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Viewplot for is an Engineering tool which is useful for plotting raw data or functional equations and FFT 
calculations generated by the program Datafit. It can be used stand-alone, or launched from within Datafit 
once the programs have been registered.    It has the ability to plot multiple curves from one or more 
datasets and display them in the same or separate windows simultaneously.    Plots can be customized by 
formatting legends, numerical scaling, line colors, fonts, line styles and axis/title labels.    The plots can be 
saved, printed or copied to the Windows clipboard for pasting into other applications.  

To learn how to use Help, press F1 or select Using Help from the Help Menu.
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Customizing Viewplot

You can change some user preferences using the Options menu. Choose Edit - Options in the main 
Viewplot window to access the following user preferences.    The changes are saved in the viewplot.ini file 
in your Windows directory for future sessions. These preferences are:

1.    Window Settings

Font Setup:    Font, Fontsize, Fontbold and FontItalic are the default font designations for plot window 
text.    The text objects for plots are listed the Plot Objects list.    These include the plot Title, Axis 
Labels, Axis Titles and plot Legends.    To change the default font designation for any of these objects, 
select the object in the list you want to change.    Click the Change Font button, and select the desired 
font from the Font Dialog box.    During installation, Ms Sans Serif is designated as the default font.    This 
is a common Windows font.    If however, your system does not have this font, you will be warned and the 
default system font for your system will be used. If you receive this warning, you can correct the problem 
here.    Only the fonts supported by your computer and printer are listed in the Fonts Dialog box.    The 
new font settings will take effect immediately upon opening any new plot windows.    To change fonts only 
within the current plot window, choose Plot - Format Axis and click on the Fonts button. All font 
information is saved when a plot is saved. 

Window Settings:.    The windows can be moved and resized once they are visible, but these setting 
determine their initial placement and size.    Default X is the designation for horizontal placement of the 
windows (in pixels).    Default Y of the designation for vertical placement of the windows (in pixels).    
Height is the window height (in pixels), and Width is, you guessed it, the window width.    To change these 
settings, enter the properties in the appropriate text boxes.    To make the windows appear full screen 
upon startup, click the Maximize Display button.    This will set the default window size to be maximized 
to the screen dimensions designated by your current video driver. You can position and size the screen 
prior to selecting Edit - Options and click the Set to Current button to set the default window settings to 
the current settings.    The Window settings will take effect the next time you run Viewplot.

Project Directory:    This is the directory where all of the projects are stored. When you install Datafit and 
Viewplot, you are prompted for the directory in which to install the executables. The default project 
directory will exist in the install directory and will be called projects.    If you want to change it, create a 
new directory (from DOS or Windows File Manager) and change the text in the Project Directory box to 
point to the new project directory.

When you exit the Options panel by selecting the Ok button, the changes you made will be automatically 
saved.    If you want to exit the panel without changing any settings, just press the Cancel button.



OPEN (File Menu)

Choosing File - Open will create a new plot window. The file dialog box will prompt you for the name of a 
Datafit equation solution file (*.dft), a Datafit FFT solution file (*.fft) a Viewplot plot file (*.plt), or a delimited 
text file (*.*).    If you selected a Datafit equation solution file or an FFT solution file, enter the path and 
filename to the file you wish to open, or use the directory listbox to change to a directory containing the 
desired file.    Once the file is read, you will be shown a list of equations with correlation coefficients and 
discreet input, or FFT data that exists in the particular file.    If you are reading a delimited text file, the the 
name of the input file will be shown in this list.    Correlation coefficients are only shown next to solved 
equations. Correlation is calculated in order to determine how well the approximation function describes 
the input data. A correlation of 1.0 indicates a perfect fit.    The approximating function is less accurate as 
the correlation decreases from a value of 1.0.

NOTE:    Solutions solved in Datafit Versions 2.1 and earlier did not save the correlation information to file, 
therefore the correlation will appear to be zero.    This will not affect the plot you are creating, but to see 
the correct correlation, re-open the project in Datafit and the files will be automatically updated.

You can load one equation (select a single item in the list by clicking on it), multiple equations (multi-
select items by holding the <Ctrl> key while selecting) or all of the equations (choose Select All).    To de-
select all of the items in the list, choose Deselect All.    At least one equation must be selected.    The 
Cubic Spline equations will be plotted with an initial default number of 100 points per spline for the range 
in which the equation is valid.    All least squares equations will be plotted at the inputted values.    FFT 
data will be plotted at the discreet frequency points determined by the sampling rate. 

By default, Least Squares equations will be plotted as continuous lines.    Input data from a solution file or 
raw data will be plotted as discreet points. Cubic Splines and FFT data are always plotted as continuous 
lines.    This method of plotting lines as discreet or continious can be changed in the Plot - Format Graphs 
menu.

If you selected a Viewplot plot file (*.plt), the plot will be read in as it was last saved and will not promp 
you for graphs to include.

If you want to plot equations or FFTs from different solutions of the same plot, use File - Import.



Import (File Menu)

Choosing File - Import will read and add equations or raw data to the active plot window.    The file dialog 
box will prompt you for the name of a Datafit FFT solution file (*.fft), an equation solution file (*.dft), or a 
delimited text file (*.*).    Enter the path and filename to the file you wish to open, or use the directory 
listbox to change to a directory containing the desired file.    Once the file is read, you will be shown a list 
of equations with correlation coefficients and discreet input, or FFT data that exists in the particular file. If 
you are reading a delimited text file, the the name of the input file will be shown in this list.    Correlation 
coefficients are only shown next to solved equations. Correlation is calculated in order to determine how 
well the approximation function describes the input data. A correlation of 1.0 indicates a perfect fit.    The 
approximating function is less accurate as the correlation decreases from a value of 1.0.

NOTE:    Solutions solved in Datafit Versions 2.1 and earlier did not save the correlation information to file, 
therefore the correlation will appear to be zero.    This will not affect the plot you are creating, but to see 
the correct correlation, re-open the project in Datafit and the files will be automatically updated.

If you are reading either type of solution file, you can load one equation (select a single item in the list by 
clicking on it), multiple equations (multi-select items by holding the <Ctrl> key while selecting) or all of the 
equations (choose Select All).    To de-select all of the items in the list, choose Deselect All.    At least 
one equation must be selected.    The equations or data in the file chosen will be added to the plot in the 
active window.    The plot will be rescaled to fit all of the plotted equations or data for their respective 
ranges. Cubic Spline equations will be plotted with the current number of points per spline.    By default, 
Least Squares equations will be plotted as continuous lines.    Input data from a solution file or raw data 
will be plotted as discreet points. Cubic Splines and FFT data are always plotted as continuous lines.    
This method of plotting lines as discreet or continious can be changed in the Plot - Format Graphs menu.

If you are reading a text delimited file, the file structure needs to be two values per line (X Y) format but 
the data can be be comma delimited, tab delimited, or space delimited, or a combination of these.    For 
example: 

1.0,2.0 is valid (comma delimited)
1.0, 2.0 is valid (comma delimited with space)
1.0 2.0 is valid (tab delimited or multiple space delimited)
1.0, 2.0 is valid (comma delimited with multiple tabs or multiple spaces)
1.0 2.0 is valid (space delimited)

It is not necessary to know the file structure being imported, the software will automatically detect this.    
All leading and trailing spaces and tabs are ignored.    If you want to import data from another software 
package, like Excel, choose File - Save as... and select Comma, Tab, or Space delimited format from the 
Excel main menu. 

Importing is useful for plotting raw data or data from different solutions in the same graph. For example, if 
Least Squares method is preferred, but the entire data set cannot accurately be described by a single 
equation, the data set can be broken up into smaller datasets.    Importing equations from different 
datasets will allow you to plot them all on the same graph.

You cannot import a Viewplot plot file into the current plot window.    You may only import Datafit equation 
solutions, FFT solutions, or delimited text files (raw data).    If you want to add equations to a saved 
Viewplot file, open the Viewplot file first, then import the Datafit solution, FFT solution or delimited text file.



Save As... (File Menu)

Choosing File - Save As... will save the current plot in Viewplot file format (*.plt).    All information, 
including line color and style information, plot axis labeling information, legend placement and fonts will 
be saved. This will allow retrieving the plot file for Printing or Importing plots at a later time.    The file will 
be save as a Viewplot plot file (*.plt).



Close (File Menu)

Choosing File - Close will close the current active plot window.    Unless you save the current plot prior to 
closing the window, any of the Axis formatting or Graph formatting you have done to the active plot will be 
lost.



Print (File Menu)

Choosing File - Print allows you to make hardcopies of the active plot window.    Although the software 
should work with any Microsoft Wondows supported printer, there may be problems with certain printers 
or printer drivers.    If you have any problems printing to any particular printer, please contact the printer 
manufacturer and obtain the latest version of the printer driver.    If this does not solve the problem, please 
contact us and give us information about the printer (Brand, Printer driver version number) as well as the 
behavior observed.



Exit (File Menu)

Choosing File - Exit will close all opened plot windows and exit Viewplot. Unless you save any opened 
plot windows prior to exiting, any of the Axis formatting or Graph Formatting you have done to any plots 
will be lost.



Licenses and Registration

You are required to register your copy of DataFit and Viewplot if you find them useful.    A lot of hard work 
went into making them, and a lot more will go into making them better.    Payment of $30.00 for a single 
user license (based on US currency) can be accepted in the following forms:

1.    Cash
2.    Check/Money Order
3.    Credit Card (Visa, Mastercard, American Express)
4.    First Virtual
5.    Invoice

You may also obtain a Site license.    Site licenses cover a single organization for an area of up to one 
hundred miles (160 km) in radius.)    The cost of a site license is $100.00 (based on U.S. currency).

This payment will cover the use of both programs.    Once you are registered, you can obtain priority 
technical support, provide input for future releases, get rid of the nagging registration screens, receive 
upgrade information, and generally feel better about yourself.

To register, select Complete Registration Form from the Registration Information panel.    The 
Registration program will appear.    Follow the detailed instructions on the form.    Depending on your 
payment option, you will be given instructions on how to send the payment.    You only need to complete 
one registration form for both Datafit and Viewplot.    The Registration program can also be launched 
from the Register icon.

To register copies of Datafit/Viewplot please use the Register program provided with 
Datafit/Viewplot to make payments. We use KAGI Shareware registration service, which accepts different 
payment methods, including credit card and invoices. If you live in the US or
Canada, you may also mail us your check or money order directly, payable to John A. Gilmore, at the 
following address:

Engineered Software
C/O John A. Gilmore
1315 Varner Road
Pittsburgh, PA 15227, USA

Once we receive the form, you will receive a confirmation letter which will include your registration 
number and license agreement.    Once you have received a registration number, you may permanently 
enter it by selecting Enter Registration from the registration information panel.    Be sure to enter your 
name EXACTLY how it is spelled on the confirmation letter. If you have any problems entering your 
registration number, please contact technical support.



Obtaining Technical Support

Shareware Evaluation Users

Questions will be addressed to the extent that answers are needed to determine whether or not 
Datafit/Viewplot will fit your needs.

You may obtain technical support in one of the following two ways:

1.    Questions by US Mail

Send your questions to:

Engineered Software 
C/O John A.Gilmore
1315 Varner Road
Pittsburgh, PA 15227

Be sure to include your return address.

2.    Questions by EMAIL

You can send Email via internet to johng@kagi.com.    Be sure to include your return address. This is 
probably the quickest way to obtain technical support.

Registered Users

In addition to the above two methods, you will receive phone support as well. Call (412) 881-4210 
between 9:00 AM and 3:00 PM Eastern Standard Time.    If there is no answer, please leave a message 
with your name, phone number and license number reported to you from the software.    You can get the 
license number by choosing About Viewplot from the Help menu.    In the near future, there will be fax 
support as well.



Format Axis (Plot Menu)

Choosing Plot - Format Axis... will allow the user to customize the physical appearance of the active 
plot. The window which will appear is described below.

Heading

The heading text box will place text on the plot which would be the title appearing above the plot. To add a 
plot heading, click in the text box and type in the desired text.    To exclude a title from the plot, leave the 
Heading text box blank, or delete the text currently in the box.    To change the font or font size of the 
heading, you can click on the Fonts button described below and change the font settings.

X Label

The X Label text box will place text on the plot which would label the horizontal X axis. To add an X Label, 
click in the text box and type in the desired text.    To exclude an X axis label from the plot, leave the X 
Label text box blank, or delete the text currently in the box. To change the font or font size of the X Label, 
you click on the Fonts button described below and change the font settings.

Y Label

The Y Label text box will place text on the plot which would label the vertical Y axis. To add a Y Label, 
click in the text box and type in the desired text.    To exclude a Y axis label from the plot, leave the Y 
Label text box blank, or delete the text currently in the box. To change the font or font size of the Y Label, 
you click on the Fonts button described below and change the font settings.

X Min, X Max, Y Min, Y Max

These text boxes allow the plot extremes to be entered to control the numerical labeling of the X and Y 
axis. The first time a data is displayed using after Opening a solution file, the extremes are automatically 
calculated so that all of the equation data is displayed for their valid ranges. If a Plot file is Opened, these 
values will read from the file to reflect the formatting of the Saved plot. To reset the minimum and 
maximum values to display all data in the plot, choose Plot - Fit All.    To change the font or font size of the 
number labels, you can go into the Options menu and change the font settings.

Major Grids, Minor Grids

Selecting the Major Grid check box will cause gridlines corresponding to the Major Ticks to be displayed. 
Selecting the Minor Grid check box will cause gridlines corresponding to the Minor Ticks to be displayed. 
These check boxes apply to both the X and Y axis.

Major Ticks, Minor Ticks

Selecting the Major Ticks checkbox will display the major    tickmarks on both the X and Y axis. The major 
ticks also control the numerical labeling on the X and Y axis. Numerical axis labels will appear 
corresponding to each of the major tickmarks. Minor tickmarks appear between the major tickmarks. The 
X and Y text boxes appearing beneath the tick and grid check boxes control the number of tick marks 
displayed on the plot.

Fonts

Selecting the Fonts button will allow you to change fonts for the active plot window. Font, Fontsize, 
Fontbold and FontItalic are the font designations for plot window text.    The text objects for plots are listed 
the Plot Objects list.    These include the plot Title, Axis Labels, Axis Titles and plot Legends.    To 
change the font designation for any of these objects, select the object in the list you want to change.    
Click the Change Font button, and select the desired font from the Font Dialog box.    Only the fonts 



supported by your computer and printer are listed in the Fonts Dialog box.    True Type fonts give the best 
results, as the appear the same on both the screen and the printer.    The new font settings will take effect 
immediately in the current    plot window.    Upon Openingany new plot windows, the default settings in the 
Edit - Options menu will initially be used.    The font information for each plot that is Saved is also saved in 
the file.    When a Plot file is saved and later re-opened, the fonts used will be the fonts that the plot was 
created with. 

Show Legends

Selecting the Show legends check box will display the plot legend. The legend will appear as a box 
containing line colors, line styles and line names for each curve in the plot. The legend box can be moved 
about the plot by clicking the left mouse button in the box and dragging the box while holding down the 
left mousebutton. When the mouse button is released, the the legend will be redisplayed in the new 
position. The position of the legend is also saved along with the plot. To customize line colors, styles and 
names, choose Plot - Format Graphs.    To change the font or font size of the Legends, you can go into 
the Options menu and change the font settings.

Number of Points per Spline

The maximum number of points per spline text box controls the number of points plotted for each cubic 
spline curve in the plot. The Cubic Spline data is read in as equations, not as discreet data points, so the 
user has control over the calculated number of points for each curve. The default number is 100, however 
for plots whose X range is very large, this number can be increased up to 1000. The number of points is 
also saved along with the plot. 



Format Graphs (Plot Menu)

Choosing Plot - Format Graphs will allow the user to customize the physical appearance of lines on the 
plot and the plot legend. The window which will appear is described below.

All of the equations or data plotted will appear in the list box. The names given by default are the equation 
type solved prefixed by the Datafit project name. If the data was imported from a delimited file, the 
filename will appear to represent the data.    These names can be changed by selecting the name in the 
listbox, and editing it in the text box beneath the list. To change the color or style of a particular line, select 
it in the list, and click on the Colors or Styles buttons. Choosing either of these two options will pop up a 
panel to allow the user to select a new color or line style. The Line Width can be controlled by using the 
spin buttons, or typing the Line Width in the line width text box.    You can specify line widths from values 
of 1 to 5.    If a line width of greater than 1 is selected, the line style is ignored.    The Display Line 
checkbox controls whether or not the line will appear on the plot and in the legend. Only the line currently 
selected in the list will be affected by any changes made. 

The Plot as Continuous checkbox will allow Least Squares equations and raw data to be plotted as 
either discreet points (point enclosed by a circle) or as continuous lines (one point connecting to the next). 
By default, Least Squares equations will be plotted as continuous lines and    input data from a solution 
file or raw data will be plotted as discreet points. Cubic Splines and FFT data are always plotted as 
continuous lines.



Fit All (Plot Menu)

Choosing Plot - Fit All will reset the minimum and maximum values to display all data in the plot. This 
action will override and reset user entries X Min, X Max, Y Min, and Y Max in the Format Axis panel.



Zoom in (Plot Menu)

Choosing Plot - Zoom In will allow the user to graphically zoom into a particular region of the plot. Once 
selected from the menu, the curser will change to an up arrow. Select the first corner of the zoom box by 
clicking and releasing the left mouse button. The zoom box will size according to the mouse position once 
the first point has been selected. Select the second corner of the box by again using the left mouse 
button. To abort the zooming process at any time, click the right mouse button. Once both corners of the 
box have been selected, the plot will be rescaled to the zoom box coordinates. This action will override 
and reset user entries X Min, X Max, Y Min, and Y Max in the Format Axis panel.



Show Coordinates (Plot Menu)

Choosing Plot - Show Coordinates will allow the user to obtain actual numerical values from the plot.    
Once selected from the menu, the curser will change to a cross-hair, and an XY coordinate box will 
appear in the top right corner of the plot window.    Move the mouse to the desired location and click the 
left mouse button.    If the point selected is an arbitrary point in the background of the plot, an x will be 
placed at the point where the mouse was clicked, and the X and Y coordinates will be displayed in the 
coordinate box.    If another point is picked, the x will relocate to the new position, and the coordinates of 
the new position will be updated.    If the point selected is within a few pixels from a vertex point of a 
plotted line, mouse will snap to the vertex, and a box will appear around the selected point.    Once the 
box appears, you can trace the line by using the left and right arrows on the keyboard.    The left arrow will 
move the box left to the next vertex on the line, and the right arrow will move the box right to the next 
vertex on the line.    If there is more than one line being displayed and you have trouble snapping to the 
desired line, both vertex points may lie within the snap tolerance.    If this happens, you can hide the 
unwanted line by first using Plot - Format Graphs and hide the unwanted line. To abort the show 
coordinate process at any time, click the right mouse button. 



Copy to Clipboard (Plot Menu)

Choosing Plot - Copy to Clipboard will capture a bitmap of the active plot and place it in the windows 
clipboard. The bitmap can then be pasted into other applications.



Warranty Information

Limited Warranty:

a.    The licensor warrants that it has the right to license the use of the licensed product(s).

b.    The Licensor warrants that the licensed product(s) will substantially perform as described in the 
products documention, provided that the licensed product(s) is installed properly on an IBM 
compatable computer running an unmodified copy of Microsoft Windows, version 3.1 or greater.

c.    This limited warranty is in lieu of all other waranties, expressed or implied, including, without limitation, 
warranties of merchantability and fitness for a particular purpose.

Limitation of Liability:

a.    Licensees sole and exclusive remedy for damage or loss in any way connected with the Licensed 
Product(s) or any services furnished by or for the Licensor, whether by breach of contract, warranty, 
due care, or breach of any other duty, shall be, at the Licensors option, (I) replacement of the Licensed 
Product(s), (ii) reperformance of services, or (iii) return to Licensee of the License Fee if non-
performance is documented within ninety (90) days of the execution of the License Agreement.

b.    The Licensor shall not be liable to Licensee or to any other person for any special, incidental, indirect 
or consequential damages whatsoever even if the Licensor has been advised of the possibility of such 
damages, including without limitation, damages for loss of goodwill, loss of profits, business 
interruptionm and computer failure or malfunction.

DISCLAIMER

While Engineered Software has made every effort to deliver a high quality and useful product, we do no 
guarentee that this product is completly free from defects.    Engineered Software is not responsible for 
any damage to the purchasers computer system or data and in no event will Engineered Software, its 
officers, directors, employees or agents be responsible to the purchaser for any consequential, incidental, 
or indirect damages (including but not limited to damages for loss of business profits, business 
interruption, or loss of data) arising out of the use or inability to use the Engineered Software product, 
even if Engineered Software has been advised of the possibility of such damages. 



Additional Information

If there are enhancements you would like to see added to Datafit/Viewplot and are a registered user, 
please dont hesitate to let us know. You can contact us by any of the methods listed in the Technical 
Support information.    We cannot guarantee that every request will be honored, but well do our best.    
Nows the time to get your requests in. 

Also, If there is a specific application you need or would like to see, we are open for suggestions.    We 
have some other projects planned for the future, but would also like to hear from you.    This can even be 
Graphical Interfaces to code you may already have (for those of you in industry with all that Fortran 
source code lying around...)

Keep an eye on our Homepage on the Web.    The address is:

http://198.207.242.3/authors/johng/, or 
http://www.kagi.com/authors/johng/ 

Dont forget the trailing slash!

Updates to the programs will be listed there, as well as new programs in the works.    New versions can 
be downloaded from the Homepage.

Thanks:

Thanks to Chuck (did you put your drums together yet?) McGowan for his constant input and 
heckling during development of this program. 

Thanks to Jon (your kids are adorable) Gotow at St. Claire Software for helping us get the ball rolling.

Thanks to Adrian (swing and a miss!) Perregaux for his ideas, QA efforts and humor.

Thanks to Greg Kochaniak (http://198.207.242.3/authors/gregko/ or gregko@kagi.com) for writing the 
Register program, and Kagi Shareware (http://198.207.242.3/) for providing their service.

Also, Thanks to Honda Corporation for making such awesome, thought provoking, fast motorcycles.

Finally, and of ultimate importance, thanks to Nancy for being in my life.






